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Chapter 182

Tests for Pairwise
Proportion Differences
in a Williams CrossOver Design
Introduction
Senn (2002) defines a cross-over design as one in which each subject receives all treatments and the objective is
to study differences among the treatments. The name cross-over comes from the most common case in which
there are only two treatments. In this case, each subject crosses over from one treatment to the other. It is assumed
that there is a washout period between treatments during which the response returns back to its baseline value. If
this does not occur, there is said to be a carry-over effect.
An a × k cross-over design contains a sequences (treatment orderings) and k time periods (occasions)
corresponding to the k treatments. The design includes a washout period between responses to make certain that
the effects of the first drug do not carry over to the second. Thus, the groups in this design are defined by the
sequence in which the drugs are administered, not by the treatments they receive.
Cross-over designs are employed because, if the no-carryover assumption is met, treatment differences are
measured within a subject rather than between subjects—making a more precise measurement. Examples of the
situations that might use a cross-over design are the comparison of anti-inflammatory drugs in arthritis and the
comparison of hypotensive agents in essential hypertension. In both cases, symptoms are expected to return to
their usual baseline level shortly after the treatment is stopped.
The sample size calculations in the procedure are based on the formulas presented in Chow, Shao, Wang, &
Lokhnygina (2018).

Advantages of Cross-Over Designs
A comparison of treatments on the same subject is expected to be more precise. The increased precision often
translates into a smaller sample size. Also, patient enrollment into the study may be easier because each patient
will receive both treatments. Finally, it is often more difficult to obtain a subject than to obtain a measurement.
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Disadvantages of Cross-Over Designs
The statistical analysis of a cross-over experiment is more complex than a parallel-group experiment and requires
additional assumptions. It may be difficult to separate the treatment effect from the period effect, the carry-over
effect of the previous treatment, and the interaction between period and treatment.
The design cannot be used when the treatment (or the measurement of the response) alters the subject
permanently. Hence, it should not be used to compare treatments that are intended to provide a cure.
Because subjects must be measured at least twice, it is often more difficult to keep patients enrolled in the study.
It is arguably simpler to measure a subject once than to obtain their measurement twice. This is particularly true
when the measurement process is painful, uncomfortable, embarrassing, or time consuming.

Technical Details
The a × k crossover design may be described as follows. Randomly assign the subjects to one of a sequence
groups with 𝑛𝑛1 subjects in sequence one, 𝑛𝑛2 subjects in sequence two, and so forth up to sequence a. In order to
achieve design balance, the sample sizes 𝑛𝑛1 , 𝑛𝑛2 , …, 𝑛𝑛𝑎𝑎 are assumed to be equal so that 𝑛𝑛1 = 𝑛𝑛2 = ⋯ = 𝑛𝑛𝑎𝑎 =
𝑛𝑛 = 𝑁𝑁/𝑎𝑎. Sequence one is given a specific sequence of k treatments, sequence two is given a different sequence
of the same k treatments, and so forth up to sequence a.

The statistical model employed by this procedure and given in Chow, Shao, Wang, & Lokhnygina (2018) assumes
that there are no sequence, period, or cross-over effects. The statistical model that incorporates these effects is
complex for binary data.

Williams Cross-Over Design
Williams cross-over designs are constructed from Latin squares as outlined in Chow and Liu (2009). If the
number of treatments (k) is even, then Williams design results in a k × k cross-over design (i.e. with k sequences
and k treatments/periods). If the number of treatments (k) is odd, then Williams design results in a 2k × k crossover design (i.e. with 2k sequences and k treatments/periods). For example, a Williams design with 4 treatments
would result in a 4 × 4 cross-over design and would have 4 sequences with 4 periods corresponding to the 4
treatments. On the other hand, a Williams design with 3 treatments would result in a 6 × 3 cross-over design and
would have 6 sequences with 3 periods corresponding to the 3 treatments.
Define 𝑦𝑦𝑖𝑖𝑖𝑖𝑖𝑖 as the binary response from subject j (j = 1, …, n) in sequence i (i = 1, …, a) given treatment l (l = 1,
…, k). Assume that the responses 𝑦𝑦𝑖𝑖𝑖𝑖𝑖𝑖 are independent and randomly distributed with 𝑃𝑃�𝑦𝑦𝑖𝑖𝑖𝑖𝑖𝑖 = 1� = 𝑃𝑃𝑙𝑙 , which
implies that there are no sequence, period, or cross-over effects. The observations taken from the same subject
may be correlated with one another.
Further define the paired differences between treatments u and v for each subject within each sequence as

and the overall true difference as

The overall difference can be estimated as

𝑑𝑑𝑖𝑖𝑖𝑖 (𝑢𝑢, 𝑣𝑣) = 𝑦𝑦𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑦𝑦𝑖𝑖𝑖𝑖𝑖𝑖
𝛿𝛿 = 𝑃𝑃𝑢𝑢 − 𝑃𝑃𝑣𝑣 .
𝑎𝑎

𝑛𝑛

1
𝛿𝛿̂ =
� � 𝑑𝑑𝑖𝑖𝑖𝑖 (𝑢𝑢, 𝑣𝑣).
𝑎𝑎𝑎𝑎
𝑖𝑖=1 𝑗𝑗=1
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The estimated difference is asymptotically normally distributed with variance 𝜎𝜎𝑑𝑑2 , which can be estimated as

where

𝜎𝜎�𝑑𝑑2

𝑎𝑎

𝑛𝑛

1
2
=
� ��𝑑𝑑𝑖𝑖𝑖𝑖 (𝑢𝑢, 𝑣𝑣) − 𝑑𝑑̅𝑖𝑖∙ (𝑢𝑢, 𝑣𝑣)� ,
𝑎𝑎(𝑛𝑛 − 1)
𝑖𝑖=1 𝑗𝑗=1

𝑛𝑛

The standard deviation, then, is

with estimate

1
𝑑𝑑̅𝑖𝑖∙ (𝑢𝑢, 𝑣𝑣) = � 𝑑𝑑𝑖𝑖𝑖𝑖 (𝑢𝑢, 𝑣𝑣).
𝑛𝑛
𝑗𝑗=1

𝑆𝑆𝑆𝑆 = 𝜎𝜎𝑑𝑑 = �𝜎𝜎𝑑𝑑2
� = 𝜎𝜎�𝑑𝑑 = �𝜎𝜎�𝑑𝑑2 .
𝑆𝑆𝑆𝑆

Test Statistic
For a two-sided test of the hypotheses

or equivalently

𝐻𝐻0 : 𝑃𝑃𝑢𝑢 − 𝑃𝑃𝑣𝑣 = 0 vs 𝐻𝐻𝐴𝐴 : 𝑃𝑃𝑢𝑢 − 𝑃𝑃𝑣𝑣 ≠ 0
𝐻𝐻0 : 𝛿𝛿 = 0 vs 𝐻𝐻𝐴𝐴 : 𝛿𝛿 ≠ 0

the power and sample size calculations are based on the test statistic
𝑍𝑍 =

𝛿𝛿̂
𝜎𝜎�𝑑𝑑
√𝑎𝑎𝑎𝑎

which is asymptotically distributed as standard normal under the null hypothesis. The null hypothesis is rejected
in favor of the alternative at level 𝛼𝛼 if
�𝛿𝛿̂ �
> 𝑍𝑍1−𝛼𝛼⁄2
𝜎𝜎�𝑑𝑑
√𝑎𝑎𝑎𝑎

where 𝑍𝑍1−𝛼𝛼⁄2 is the upper 1 − 𝛼𝛼 ⁄2 percentile of the standard normal distribution. One-sided tests reject the null
hypothesis at level 𝛼𝛼 if
�𝛿𝛿̂ �
> 𝑍𝑍1−𝛼𝛼
𝜎𝜎�𝑑𝑑
√𝑎𝑎𝑎𝑎

where 𝑍𝑍1−𝛼𝛼 is the upper 1 − 𝛼𝛼 percentile of the standard normal distribution.

Bonferroni Adjustment for Multiple Tests

In a design with k treatments, there are 𝑘𝑘(𝑘𝑘 – 1)/2 possible pairwise (u, v) comparison tests. To protect the
overall alpha level, the individual test alpha level if often divided by the number of tests performed. This is known
as the Bonferroni adjustment for multiple comparisons. When this adjustment is used in hypothesis testing, the
individual test alpha value of 𝛼𝛼/(𝑘𝑘(𝑘𝑘 – 1)/2) is substituted for 𝛼𝛼 in the formulas above.
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Power Calculation
According to Chow, Shao, Wang, & Lokhnygina (2018) page 89, the power for the two-sided test of 𝐻𝐻0 : 𝛿𝛿 = 0
versus 𝐻𝐻𝐴𝐴 : 𝛿𝛿 ≠ 0 is
|𝛿𝛿1 |
Φ � 𝜎𝜎 − 𝑍𝑍1−𝛼𝛼⁄2 �
𝑑𝑑
√𝑎𝑎𝑎𝑎

where Φ() is the standard normal distribution function, 𝛿𝛿1 is a value of the difference under the alternative
hypothesis, and 𝑍𝑍1−𝛼𝛼⁄2 is the upper 1 − 𝛼𝛼 ⁄2 percentile of the standard normal distribution. The sample size
calculation formula for a two-sided test is
2

The power for a one-sided test is

�𝑍𝑍1−𝛼𝛼⁄2 + 𝑍𝑍1−𝛽𝛽 � 𝜎𝜎𝑑𝑑2
𝑛𝑛 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 �
�.
𝑎𝑎𝛿𝛿12
|𝛿𝛿1 |
Φ � 𝜎𝜎 − 𝑍𝑍1−𝛼𝛼 �
𝑑𝑑
√𝑎𝑎𝑎𝑎

where 𝑍𝑍1−𝛼𝛼 is the upper 1 − 𝛼𝛼 percentile of the standard normal distribution. The sample size calculation formula
for a one-sided test is
2

�𝑍𝑍1−𝛼𝛼 + 𝑍𝑍1−𝛽𝛽 � 𝜎𝜎𝑑𝑑2
𝑛𝑛 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 �
�.
𝑎𝑎𝛿𝛿12

Bonferroni Adjustment for Multiple Tests

In a design with k treatments, there are 𝑘𝑘(𝑘𝑘 – 1)/2 possible pairwise (u, v) comparison tests. To protect the
overall alpha level, the individual test alpha level if often divided by the number of tests performed. This is known
as the Bonferroni adjustment for multiple comparisons. When this adjustment is used in power calculations, the
individual test alpha value of 𝛼𝛼/(𝑘𝑘(𝑘𝑘 – 1)/2) is substituted for 𝛼𝛼 in the formulas above.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most
conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment that has already been run.
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Select Effect Size (D1) when you want to calculate the minimum effect size that can be detected for a particular
scenario.

Test
Alternative Hypothesis
Specify whether the test is one-sided or two-sided. When a two-sided hypothesis is selected, the value of alpha is
split in half. Everything else remains the same.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal means when in fact the means are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
means when in fact the means are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
Adjust Alpha for Multiple Tests
Check this box to adjust the alpha-level for each individual test to maintain the overall experiment-wise error rate
of Alpha.
The adjustment is made using the Bonferroni method where the overall Alpha is divided by the number of tests.
The total number of tests is equal to k(k-1)/2, where k is the number of treatments.

Sample Size / Treatments
k (Number of Treatments)
This is the number of treatments given to each subject in each sequence.
Number of Sequences
If k is even, the number of sequences (a) in Williams design is equal to k, resulting in a k x k cross-over design. If
k is odd, the number of sequences (a) in Williams design is equal to 2k, resulting in a 2k x k cross-over design.
Number of Tests
The total number of tests is equal to k(k-1)/2.
Range
k ≥ 2.
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n (Sample Size per Sequence)
This is the sample size of each sequence in the Williams cross-over design. The individual sequence sample sizes
are assumed to be equal such that the total sample size is equal to
N = an
where a is the number of sequences. If the number of treatments (k) is even, the number of sequences (a) in
Williams design is equal to k, resulting in a k x k cross-over design. If k is odd, the number of sequences (a) in
Williams design is equal to 2k, resulting in a 2k x k cross-over design.
You can enter a single value such as 50 or a list of values using the syntax 50 100 150 200 250 or 50 to 250 by 50.

Effect Size – Difference
D1 (Minimum Difference|H1)
Enter a value for the minimum treatment difference to detect under the alternative hypothesis, H1. The power
calculations assume that this is the actual value of the difference.
D1 = Minimum of (Pᵤ - Pᵥ)|H1 for u, v = 1, ..., k with u ≠ v
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.3 by 0.1 in the range
-1 < D1 < 1, D1 ≠ 0.

Effect Size – Standard Deviation of Paired
Differences
Standard Deviation (SD)
Enter a value for the standard deviation of the paired differences, SD.
Estimating SD using Previous Cross-Over Data
The standard deviation may be estimated using cell counts from a previous cross-over study with n subjects per
sequence as described on pages 88 and 89 of Chow, Shao, Wang, & Lokhnygina (2018).
Assume that y_ijl is the binary treatment response for the jth subject (j = 1 to n) in the ith sequence (i = 1, ..., a)
given the lth treatment (l = 1, ..., k). Note that we assume that there are equal numbers of subjects in each
sequence such that n_1 = n_2 = ... = n_a = n.
Define
d_ij_(u,v) = y_iju - y_ijv
dbar_i._(u,v) = (1/n)Σⱼ[d_ij_(u,v)]
The formula for SD is then
SD = √[(ΣᵢΣⱼ(d_ij_(u,v) - dbar_i._(u,v))²)/(a(n-1))].
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Example 1 – Power Analysis
Suppose you want to consider the power of a balanced Williams cross-over design with 3 groups and a binary
endpoint where the test is computed based on the difference for sequence sample sizes between 30 and 100. The
minimum difference to detect is 0.2 and the estimated standard deviation of the paired differences is 1. The
overall significance level is 0.05 with individual test alpha adjusted for 3 tests.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Pairwise Proportion Differences in a Williams Cross-Over Design procedure
window by expanding Proportions, then Cross-Over (Williams) Design, then clicking on Test (Inequality),
and then clicking on Tests for Pairwise Proportion Differences in a Williams Cross-Over Design. You may
then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Two-Sided
Alpha ....................................................... 0.05
Adjust Alpha for Multiple Tests ............... Checked
k (Number of Treatments) ...................... 3
n (Sample Size per Sequence) ............... 30 to 100 by 10
D1 (Minimum Difference|H1) .................. 0.2
Standard Deviation (SD) ......................... 1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Two-Sided Test in a 6x3 Williams Cross-Over Design ─────────────────────
H0: Pᵤ - Pᵥ = 0 vs. H1: Pᵤ - Pᵥ ≠ 0 for u, v = 1, ..., 3 with u ≠ v.
Number of Possible Tests = 3

Power
0.61382
0.75941
0.85772
0.91936
0.95588
0.97658
0.98789
0.99388

Sequence
Sample
Size
n
30
40
50
60
70
80
90
100

Total
Sample
Size
N
180
240
300
360
420
480
540
600

Minimum
Difference
D1
0.200
0.200
0.200
0.200
0.200
0.200
0.200
0.200

Standard
Deviation
SD
1.000
1.000
1.000
1.000
1.000
1.000
1.000
1.000

Overall
Alpha*
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

Individual
Test
Alpha*
0.017
0.017
0.017
0.017
0.017
0.017
0.017
0.017

* Alpha was adjusted for 3 tests using the Bonferroni method. Power was calculated using Individual Test Alpha.
References
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third
Edition. Chapman & Hall/CRC. Boca Raton, Florida.
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
n is the sample size in each sequence.
N is the total sample size from all 6 sequences combined. The sample is divided equally among sequences.
D1 is the minimum treatment difference to detect under the alternative hypothesis. D1 = Minimum of (Pᵤ Pᵥ)|H1 for u, v = 1, ..., k with u ≠ v.
SD is the standard deviation of paired differences. This is estimated from a previous study.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Summary Statements ─────────────────────────────────────────────────────────
For a 6x3 Williams Cross-Over Design, a sample size of 30 in each sequence for a total of 180
achieves 61.382% power to detect a difference of 0.200 using a two-sided test with an overall
significance level of 0.050 and individual test Bonferroni-adjusted significance level of 0.017
when the standard deviation of paired differences is 1.000.
Dropout-Inflated Sample Size ────────────────────────────────────────────────────

Sample Size
Ni
30
180

DropoutInflated
Enrollment
Sample Size
Ni'
38
228

Expected
Number of
Dropouts
Di
8
48

Group
1-6
Total

Dropout Rate
20%

1-6
Total

20%

40
240

50
300

10
60

1-6
Total

20%

50
300

63
378

13
78

1-6
Total

20%

60
360

75
450

15
90

1-6
Total

20%

70
420

88
528

18
108

1-6
Total

20%

80
480

100
600

20
120

1-6
Total

20%

90
540

113
678

23
138

1-6
Total

20%

100
600

125
750

25
150

Definitions
Group lists the group numbers.
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the
course of the study and for whom no response data will be collected (i.e. will be treated as "missing").
Ni is the evaluable sample size for each group at which power is computed (as entered by the user). If Ni
subjects are evaluated out of the Ni' subjects that are enrolled in the study, the design will achieve the
stated power.
Ni' is the number of subjects that should be enrolled in each group in order to end up with Ni evaluable
subjects, based on the assumed dropout rate. Ni' is calculated by inflating Ni using the formula Ni' = Ni /
(1 - DR), with Ni' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., Shao, J., and
Wang, H. (2008) pages 39-40.)
Di is the expected number of dropouts in each group. Di = Ni' - Ni.
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Charts Section

This report shows the values of each of the parameters, one scenario per row. This plot shows the relationship
between sample size and power. We see that a sample size of just over 40 per sequence is required to detect a
minimum difference of 0.2 with 80% power.
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Example 2 – Calculating Sample Size (Validation using Chow,
Shao, Wang, & Lokhnygina (2018))
On page 91, Chow, Shao, Wang, & Lokhnygina (2018) presents an example of finding the sample size required in
a 6 × 3 Williams cross-over design (k = 3) to detect a difference of 0.2 with 80% power and a significance level of
0.05 when the standard deviation of paired differences is 0.75. They compute the required sample size to be 19
per sequence. Note that there is no adjustment for multiple testing in this example.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Pairwise Proportion Differences in a Williams Cross-Over Design procedure
window by expanding Proportions, then Cross-Over (Williams) Design, then clicking on Test (Inequality),
and then clicking on Tests for Pairwise Proportion Differences in a Williams Cross-Over Design. You may
then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Adjust Alpha for Multiple Tests ............... Unchecked
k (Number of Treatments) ...................... 3
D1 (Minimum Difference|H1) .................. 0.2
Standard Deviation (SD) ......................... 0.75

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Two-Sided Test in a 6x3 Williams Cross-Over Design ─────────────────────
H0: Pᵤ - Pᵥ = 0 vs. H1: Pᵤ - Pᵥ ≠ 0 for u, v = 1, ..., 3 with u ≠ v.
Number of Possible Tests = 3

Power
0.81253

Sequence
Sample
Size
n
19

Total
Sample
Size
N
114

Minimum
Difference
D1
0.200

Standard
Deviation
SD
0.750

Alpha*
0.050

* Alpha was not adjusted for multiple tests.

The result from PASS matches the result from Chow, Shao, Wang, & Lokhnygina (2018) exactly.
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